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Introduction

When Microsoft released XNA in December 2006, it immediately became clear that this new 
technology would have a major impact on the possibilities for game developers. XNA was designed 
from the ground up with ease of use in mind, while not sacrificing performance or capabilities 
to achieve this goal. As a bonus, any game you create in XNA for the PC also runs on the Xbox 360 
console!

In the span of one year, a large user community has grown around XNA. You can find code 
examples on a vast number of sites, ask your questions in one of the lively forums, or even meet 
local people who share the same passion in one of the XNA User Groups.

Whether you want to get up to speed with XNA quickly or you have tried some of the tutorial 
sites and are looking for the next step, this book is for you. With almost 100 recipes dealing with 
various challenges you may encounter during your journey with XNA, this book covers each 
corner of the XNA Framework.

The first recipes of the chapters in this book explain some stand-alone concepts and have 
been kept as clear as possible. As an example, a recipe explaining how to load a 3D Model from 
a file and render it to the screen will not render any trees in the background to make the final 
result look nicer, because this would clutter the code and make it more complex than it should be.

On the other hand, each chapter ends with some recipes that combine all you’ve learned 
thus far into something new and powerful. As such, you can step through the recipes, building 
up your experience in XNA as you move to the next recipe.

This book explains the functionality of the XNA 2.0 Framework. If any updates are made to 
the XNA Framework in the future, I will update the code for this book and make it available for 
download from my web site at http://www.riemers.net/.

If you have any questions regarding the text or code examples found in this book, I kindly 
invite you to post them on the forum on my site so you can get an answer as soon as possible.

The XNA Framework is roughly dividable into three parts. The main part contains your 
XNA project and its code. Next in line is the content pipeline, a flexible component allowing you 
to preprocess any art assets you want to load into your XNA project. Last, but definitely not least, 
are the HLSL effects, which are used mainly to improve the visual quality of the final image you 
render to the screen. Although each chapter starts with some recipes that cover the XNA function-
ality related to the chapter, this book can also be used as a detailed guide to the content pipeline 
and to HLSL effects, as explained in the following sections.

Content Pipeline
If you’re interested in getting into the XNA content pipeline, I advise you to read the following 
recipes in this order:

3-9. Extend the Image Content Processor

3-10. Extend the Image Content Processor: Grayscale Conversion and Processor Parameters



xviii ■IN TR O D U CT IO N  

4-13. Gain Direct Access to Vertex Position Data by Extending the Model Processor

4-14. Gain Direct Access to Vertex Position Data of Each ModelMesh by Extending the 
Model Processor

4-15. Gain Direct Access to Vertex Position Data by Defining a Custom TypeWriter and 
TypeReader

4-16. Store Multiple Objects in the Tag Property by Defining a Custom TypeWriter and 
TypeReader

5-13. Load Data from an XML File

5-12. Write a Custom Content Importer: Loading a Terrain from a CSV File

5-11. Extend the TextureProcessor to Generate a Terrain Object from an Image: Advanced 
DOM Objects

HLSL
This book also contains a lot of HLSL samples. You can follow these recipes in this order:

6-5. Add HLSL Vertex Shading

6-6. Define a Point Light Using HLSL

6-7. Add HLSL Per-Pixel Lighting

6-8. Define a Spotlight Using HLSL

6-9. Add HLSL Specular Highlights

6-10. Add Multiple Lights to Your Scene Using Deferred Shading

5-14. Create Your Own Vertex Format

5-15. Introducing Bump Mapping: Fixed Normal

5-16. Adding Per-Pixel Detail by Bump Mapping in Tangent Space

3-11. Make Your Scene More Impressive with Billboarding: Render 2D Images in a 3D 
World So They Always Face the Camera

3-12. Create a 3D Explosion Effect/Simple Particle System

2-13. Define an Orthogonal Projection Matrix to Generate a Depth Map of the Scene

3-13. Create a Mirror: Projective Texturing

6-11. Add Shadowing Capability to Your Deferred Shading Engine

5-17. Add an Ocean to Your 3D World
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■ ■ ■

C H A P T E R  1

Getting Started with XNA 2.0

The first part of this chapter will get you up and running with XNA 2.0 by guiding you through 
the installation process and helping you get your code running on a PC and on the Xbox 360 
console. The second part of this chapter contains some more advanced topics for those inter-
ested in the inner workings of the XNA Framework.

Specifically, the recipes in this chapter cover the following:

• Installing XNA Game Studio 2.0 and starting your first XNA 2.0 project (recipes 1-1 
and 1-2)

• Running your code on PCs and on the Xbox 360 console (recipes 1-3 and 1-4)

• Learning more about the timing followed by the XNA Framework (recipe 1-5)

• Making your code plug-and-play using GameComponent classes and GameServices 
(recipes 1-6 and 1-7)

• Allowing the user to save and load their games using XNA’s storage capabilities (recipe 1-8)

1-1. Install XNA Game Studio 2.0

The Problem
You want to start coding your own games.

The Solution
Before you can start coding your own games, you should install your development environment. 
XNA Game Studio 2.0 allows you to create your whole game project using a single environment. 
Best of all, it’s completely free to install.

First you need a version of Visual Studio 2005 that allows you to develop C# programs. This 
is required, because XNA uses C#.

On top of Visual Studio 2005, you will install XNA Game Studio 2.0.
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How It Works

Installing Visual Studio 2005

XNA Game Studio 2.0 requires Visual Studio 2005 to be installed on your PC. If you don’t have 
Visual Studio or if you have Visual Studio 2008 installed, you can download the Visual C# 2005 
Express Edition for free.

To do this, go to http://creators.xna.com/education/newtoxna.aspx, and click the Install 
Visual C# 2005 Express Edition link. On the next page, make sure you select the C# version, 
indicated by the green color. Select the language of your choice, and hit the Download button. 
This will download a very small file, which you should run afterward.

During setup, use the default selections and hit Next until the program starts downloading 
and installing.

■Note  You can find updated links to these packages on the Download section of my site (http://
www.riemers.net).

■Note  Visual Studio 2008 and Visual C# Express Edition 2005 will work side by side.

Updating Visual Studio 2005

XNA 2.0 requires the latest Service Pack for Visual Studio 2005 to be installed. Return to the site 
from where you downloaded Visual C# 2005 Express Edition, and scroll down to the “Step 2” 
section. Click the Download Visual C# 2005 Express SP1 link to download the Service Pack. 
Once downloaded, run the file to install the Service Pack.

Installing XNA Game Studio 2.0

Finally, return to http://creators.xna.com/education/newtoxna.aspx, and scroll down to the 
“Install XNA Game Studio 2.0” section, where you should click the first link. On the page that 
opens, click the Download button (just above the “Quick Details” section) to download XNA 
Game Studio 2.0.
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Once you’ve downloaded and run the file, the installer will check whether you have installed 
Visual C# Express Edition 2005 with Service Pack 1. If you have followed the instructions in the 
previous section, you shouldn’t be getting any error messages.

During setup, you will be presented with the Firewall Setup page. Make sure you select the 
first option, “Yes, I wish to select these rules to enable,” and allow both suboptions. If you don’t, 
you will run into trouble when connecting to your Xbox 360 or when testing multiplayer games 
between multiple PCs.

Finally, hit the Install button to install XNA Game Studio 2.0.

1-2. Start Your First XNA 2.0 Project

The Problem
You want to start coding a new XNA 2.0 game. In addition, the default startup code already 
contains a few methods, so you want to know what these are for and how they help make your 
life easier.

The Solution
Opening a new project is the same in most Windows programs. In XNA Game Studio 2.0, go to 
the File menu, and select New ➤ Project.

How It Works

Starting XNA Game Studio 2.0

Start XNA Game Studio 2.0 by clicking the Start button and selecting Programs. Find Microsoft 
XNA Game Studio 2.0, click it, and select Microsoft Visual Studio 2005 (or Microsoft Visual C# 
2005 Express Edition if you installed the free version).

Starting a New XNA 2.0 Project

In XNA Game Studio 2.0, open the File menu and select New ➤ Project. In the list on the left, 
XNA Game Studio 2.0 under Visual C# should be highlighted by default, as shown in Figure 1-1. 
On the right, highlight Windows Game (2.0). Give your new project a fancy name, and hit the 
OK button.
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Figure 1-1. Starting a new XNA 2.0 project (Visual Studio 2005 edition)

Examining the Predefined Methods

When you start a new XNA 2.0 project, you will get a code file already containing some code. 
Comments (shown in green) make up more than 50 percent of the code to help you get started.

In a few moments, you will find that the methods you’re presented with really are quite 
useful, because they greatly reduce the time you would otherwise spend doing basic stuff. For 
example, when you run your project at this moment, you will already be presented with an 
empty window, meaning you don’t have to waste your time coding a window or processing the 
window’s message queue.

The predefined methods are discussed in the following sections.

Game1 Constructor

The Game1 method is called once, at the very moment your project is run. This means none of 
the internal clockwork has been initialized the moment this method (the constructor) is called. 
The only code you should add here consists of the instantiations of GameComponent classes (see 
recipe 1-6), because you cannot access any resources (such as the GraphicsDevice class) since 
they haven’t been initialized yet at this point.

Initialize Method

The Initialize method is also called once, after all the internal initialization has been done. 
This method is the ideal place to add your initialization values, such as the starting positions 
and starting speeds of the objects of your game. You have full access to all resources of your 
Game object.
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Update Method

When running your game, XNA will make its best effort to call the Update method exactly 60 times 
per second (once every 0.0167 seconds). For more information on this timing, read recipe 1-5.

This makes the Update method an excellent place to put your code that updates the logic 
of your game. This can include updating the positions of your objects, checking whether some 
objects collide, starting an explosion at that position, and increasing the score.

Also, processing user input and updating camera/model matrices should be done here.

Draw Method

While running the game, XNA will call the Draw method as frequently as possible, keeping in 
mind that the Update method should be called 60 times per second.

In this method, you should put the code that renders your scene to the screen. It should 
render all 2D images, 3D objects, and explosions to the screen, as well as display the current 
score.

LoadContent Method

Whenever you start a game, you will want to load art (such as images, models, and audio) from 
disk. To speed things up and allow a huge flexibility, XNA manages this art through the content 
pipeline.

All art loading should be done in the LoadContent method. This method is called only once 
at the beginning of your project.

A detailed example on how to load a 2D image into your XNA project is given in recipe 2-1. 
The same approach can be used to load any kind of art.

UnloadContent Method

If some of the objects used in your game require specific disposing or unloading, the UnloadContent 
method is the ideal spot to do this. It is called once, before the game exits.

Adding an .fx HLSL File

In case you want to go one step further and add an HLSL file to your project, simply find the 
Content entry in your Solution Explorer at the top-right of your screen. Right-click it, and select 
Add ➤ New Item. Select “Effect file,” and give it a name of your choice.

You’ll get some default code, which you’ll want to extend or replace with code you find 
elsewhere in this book. After that, you need to import it like any other content object: by creating a 
suitable variable and linking this file to that variable.

Add this variable to the top of your main Game class:

Effect myEffect;

Then link it to your code file in the LoadContent method:

protected override void LoadContent()
{
    myEffect = Content.Load<Effect>("effectFile");
}
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■Note  You’ll have to change the name of the asset, effectFile in this case, to the name of your HLSL file.

1-3. Deploy Your XNA2.0 Game on Xbox 360

The Problem
Once you have created and tested your code on the PC, you want to upload your game to and 
run it on your Xbox 360.

The Solution
One of the nicest innovations of XNA is that you can make your code run on both PCs and on 
Xbox 360, without having to change anything. There are a few prerequisites before you can 
upload your working code to Xbox 360, though.

First, you need to have an Xbox Live account, which can be created for free through the 
http://creators.xna.com site or on Xbox 360.

Next, you need a Creators Club license, which is free for most students or can be bought 
through the Xbox Live Marketplace. This license costs $49 USD for four months or $99 USD for 
one year.

Next, you need to download and install XNA Game Studio Connect, the front-end program 
that listens for a connection from your PC.

Last but definitely not least, you need a LAN connection between your PC and Xbox 360, 
and the Xbox 360 should be connected to the Internet. The PC and Xbox 360 should also be 
paired, because you would otherwise run into trouble when you have multiple Xbox 360 
consoles in your network.

Once you have fulfilled these four prerequisites, you can upload and run your code on 
Xbox 360 from within XNA Game Studio 2.0 on your PC very easily.

How It Works

Setting Up the Xbox Live Account

Signing up for a Silver Xbox Live account is free and required if you want to run your own code 
on your Xbox 360 console. If you have already used your Xbox 360 console, you’ll probably 
already have a Live account. If you haven’t, start your Xbox 360 console, insert a game disc, and 
follow the instructions on your screen.

Obtaining the Creators Club License

If you are a student, chances are you can obtain a free license from the Microsoft DreamSpark 
program. You can access this from http://downloads.channel8.msdn.com. Log in with your 
student credentials to obtain a code, which you can enter by going to the Marketplace tab in 
your XBox360 dashboard and choosing “Redeem code.”
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Otherwise, you can simply log your Xbox 360 console on to the Xbox Live Marketplace and 
then navigate to Games ➤ All Game Downloads. In the list, find XNA Creators Club, and select it.

 Then select Memberships, and you can buy a license for four months or for one year. 
Alternatively, you can also enter a code that you can find on a Creators Club voucher card.

Installing XNA Game Studio Connect on Your Xbox 360

This program makes your Xbox 360 listen for any incoming connections from your PC.
You can download this for free by going to the Xbox Live Marketplace and browsing to 

Game Store ➤ More ➤ Genres ➤ Other. Start the program after you’ve finished installing it.

Connecting Your Xbox 360 and PC

Before your PC can stream data to the Xbox 360, the two devices need to be connected by a LAN 
and to the Internet. If both your Xbox 360 and PC are attached to a router/switch/hub, this 
should be OK.

Nowadays, more and more home networks are relying on a wireless network. This might 
be a problem, because the Xbox 360 doesn’t ship with a wireless adapter by default. One solu-
tion is to have a PC with both a wireless and a wired (Ethernet) network, which is common for 
most new laptops. Connect the PC to your wireless network at home, and add a $5 patch cable 
between your Xbox 360 and PC. Finally, on your PC, click the Start button, and navigate to 
Settings ➤ Network Connections. Highlight both your wireless and Ethernet adapters, right-
click one, and select Bridge Connections, as shown in Figure 1-2. Wait for a few minutes, and 
both machines should be connected to the Internet and to each other!

Figure 1-2. Bridging two network adapters on one PC

Pairing Your PC and Xbox 360

In case you have multiple Xbox 360 consoles in your network, you should specify to which Xbox 
360 you want to upload your code. If you haven’t done already, start XNA Game Studio Connect 
on your Xbox 360 by going to the Game tab and selecting Games Library ➤ My Games ➤ XNA 
Game Studio Connect. If this is the first time you’ve launched Connect, you will be presented 
with a series of five five-character strings that identifies your Xbox 360.

On your PC, click the Start button, and navigate to Programs ➤ Microsoft XNA Game 
Studio 2.0 ➤ XNA Game Studio Device Center. Click the Add Device button, and give your Xbox 
360 console a name of your choosing. Next, you are invited to enter the serial number shown 
by your Xbox 360. If both your Xbox 360 and PC are connected by the network, the pairing 
should succeed, and your console should appear in the device list. The green sign indicates 
your currently active Xbox 360, in case you have paired your PC to multiple Xbox 360 consoles.
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Generating an Xbox 360 Project from an Existing XNA 2.0 Project

In XNA Game Studio 2.0, it’s easy to convert your PC game to an Xbox 360 project. Simply open 
your project, and find the Solution Explorer at the top-right of your screen. Right-click your 
project’s name, and select Create Copy of Project for Xbox 360, as shown in Figure 1-3.

Figure 1-3. Generating an Xbox 360 project

This will result in a second project being created and added to your solution. All files of 
your original project will be referenced by new project. They will be referenced, not copied, so 
any changes you make in a file in one project will be visible in the other project as well.

In some cases, you might need to add some references that the wizard has forgotten to 
copy, but all in all, the wizard will save you quite some time.

From now on, you can select on which target you want to run your project at the top of 
your screen, as shown in Figure 1-4.

Figure 1-4. Selecting the deployment target

Select Xbox 360 from the list. Make sure your Xbox is running XNA Game Studio Connect 
and is waiting for a connection. When you hit F5, your files will be uploaded to and executed on 
your Xbox 360 console!

1-4. Deploy Your XNA2.0 Game on Another PC

The Problem
You have finished a first version of your game and want to show it off to a friend on his PC. 
However, when you double-click the .exe file, you get some errors.
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The Solution
Distributing XNA games to different PCs still is one of the major issues requiring attention from 
the XNA team. At the time of this writing, you have to install three separate installation packages 
before you can feel safe running your game’s executable.

The three packages you need to install are as follows:

• The XNA Framework Redistributable 2.0

• The .NET 2.0 Framework SP1

• The DirectX 9.0c Runtime files

In addition, in case you want to use the networking functionality in XNA 2.0 (see Chapter 8), 
you’ll have to install the complete XNA Game Studio 2.0 package on the destination PC!

How It Works
The executables created by XNA 2.0 will assume some basic XNA 2.0 files to be installed on the 
system. Therefore, if your game cannot detect these files on the system, you will get some errors.

Installing the XNA 2.0 Framework Files

You can solve this by downloading and installing the XNA Framework Redistributable 2.0, 
which you can find by searching for it on the Microsoft site at http://www.microsoft.com. The 
package is very small (2MB) and contains all the basic XNA 2.0 Framework files.

■Note  As in recipe 1-1, you can find updated links to all of these packages in the Download section of my 
site at http://www.riemers.net.

Installing the .NET 2.0 SP1 Files

XNA is the new managed wrapper around DirectX. Because it uses a managed .NET language 
(C#), you’ll also need to make sure the .NET Framework 2.0 (or later) files are present on the 
system. You can download this package from the Microsoft site by searching for .NET 2.0 SP1 
(x86) or for .NET 2.0 SP1 (x64) for newer 64-bit machines.

Installing DirectX 9.0c

Because XNA is based on DirectX, it makes sense that you also need to install the DirectX runtimes. 
Once again, you can download this package from the Microsoft site; just search for DirectX 
End-User Runtime. Because this is a web installer, the download size will depend on the parts 
of DirectX already present on the target system.

Distributing Networking Games

At this moment, in order to run networking games on multiple PCs, you need to have XNA 
Game Studio 2.0 completely installed on all systems.
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Copying Compiled Files

After you’ve compiled and tested your game, go to the executable directory, which can be any 
combination between bin\x86\Debug and bin\x64\Release. Make sure you copy all files and 
submaps you find that map to the destination PC. If you installed all three packages, you 
shouldn’t receive any error messages when you double-click the .exe file to start your game.

1-5. Customize Game Loop Timing

The Problem
You want to change the default timing intervals at which the Update and Draw methods are called.

The Solution
By default, the Update method is called exactly 60 times each second, while the Draw method is 
called as often as possible, with the refresh rate of your screen as the maximum.

By changing the values of the TargetElapsedTime and IsFixedTimeStep static properties of 
the Game class and the SynchronizeWithVerticalRetrace property of the GraphicsDevice class, 
you can change this default behavior.

How It Works

Changing the Update Frequency

By default, the Update method of your Game is called exactly 60 times each second, or once every 
16.667 milliseconds. You can change this by changing the value of the TargetElapsedTime variable:

this.TargetElapsedTime = TimeSpan.FromSeconds(1.0f / 100.0f);

When you call this line of code, XNA will make sure the Update method will be called 
100 times per second.

You can also instruct XNA not to call the Update method at regular intervals but instead 
each time before the Draw method is called. You do this by setting the IsFixedTimeStep variable 
to false:

this.IsFixedTimeStep = false;

Using IsRunningSlowly

You can specify an Update frequency of your choice; however, when the number specified is too 
high, XNA will not be able to call your Update method at that frequency. If this is the case, the 
gameTime.IsRunningSlowly variable will be set to true by XNA:

Window.Title = gameTime.IsRunningSlowly.ToString();
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■Note  You should check the gameTime argument passed to the Update method, and not the gameTime 
argument passed to the Draw method, to verify this.

Changing the Draw Frequency

By default, XNA will call the Draw method one time for each refresh cycle of your monitor.
Usually, there’s absolutely no need for your Game to call its Draw method more frequently 

than your screen can refresh and update itself. If you, for example, render your scene into the 
back buffer of your graphics card five times for each time your screen updates itself, only one 
of the five results will actually be rendered to the screen.

In some cases, it can be useful to call your Draw method at maximum frequency, such 
as when determining the maximum frame rate of your Game. You can do this by setting the 
graphics.SynchronizeWithVerticalRetrace variable to false:

graphics.SynchronizeWithVerticalRetrace = false;

■Note  You must put this line in the Game1 constructor at the top of your code, because XNA needs to be 
aware of this before it creates GraphicsDevice.

1-6. Make Your Code Plug-and-Play 
Using GameComponents

The Problem
You want to separate part of your application into a GameComponent class. This will ensure 
reusability of the component in other applications.

The Solution
Certain parts of your applications are separate from the rest of your application. In an XNA 
application, most such parts need to be updated or drawn. Examples of such parts might be a 
particle or billboard system (see recipes 3-11 and 3-12).

One step in the correct direction is to create a separate class for such a part. In your main 
XNA Game class, you will then need to create an instance of this class, initialize it, update it each 
time, and, if applicable, render it to the screen. Therefore, you will want your new class to have 
its own Initialize, (Un)LoadContent, Update, and Draw methods so you can easily call them 
from within your main XNA Game class.

If you find yourself defining these methods in your new class, it might be a nice idea to 
make your new class inherit from the GameComponent class. If you do this, you can add it to the 
Components list of your Game. This will cause the Initialize method of your GameComponent class 
(if you defined one) to be called after the Initialize class of your main Game class finishes. 
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Furthermore, each time the Update method of your main Game class finishes, the Update method 
of your GameComponent class will be called automatically.

If your component should also render something, you should inherit from the 
DrawableGameComponent class instead of from the GameComponent class. This will expect that your 
component also contains a Draw method, which will be called after the Draw method of your 
main Game class finishes.

■Note  At the end of the Initialize method in your main Game class, you’ll notice the call to base.
Initialize. It is this line that starts calling the Initialize methods of all the GameComponent classes 
of your Game class. You can find the same kind of call at the end of the other methods in your main Game class.

How It Works
As an example, the billboarding code of recipe 3-11 will be separated into a GameComponent 
class. Even better, because this code also needs to render something to the screen, you will 
make it a DrawableGameComponent class.

Creating a New (Drawable)GameComponent

Add a new class file to your project by right-clicking your project and selecting Add ➤ New File. 
Then select Class; I called my new class BillboardGC. In the new file that is presented to you, 
you’ll want to add the XNA using lines, which can be done very easily by copying the using 
block of your main Game class into the new class.

Next, make sure you make your new class inherit from the GameComponent class or the 
DrawableGameComponent class, as shown in the first line of the following code snippet. Add all 
the code of the component, and separate it nicely between the Initialize, (Un)LoadContent, 
Update, and Draw methods of your new class.

The following example shows how this can be done for the billboarding code of recipe 3-11. 
Some methods such as CreateBBVertices have not been fully listed, because in this recipe you 
should focus on the Initialize, LoadContent, Update, and Draw methods.

class BillboardGC : DrawableGameComponent
{
    private GraphicsDevice device;

    private BasicEffect basicEffect;
    private Texture2D myTexture;
    private VertexPositionTexture[] billboardVertices;
    private VertexDeclaration myVertexDeclaration;
    private List<Vector4> billboardList = new List<Vector4>();

    public Vector3 camPosition;
    public Vector3 camForward;
    public Matrix viewMatrix;
    public Matrix projectionMatrix;
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    public BillboardGC(Game game) : base(game)
    {
    }

    public override void Initialize()
    {
        device = Game.GraphicsDevice;
        base.Initialize();
    }

    protected override void LoadContent()
    {
        basicEffect = new BasicEffect(device, null);
        myTexture = Game.Content.Load<Texture2D>("billboardtexture");
        AddBillboards();
        myVertexDeclaration = new VertexDeclaration(device, ➥

        VertexPositionTexture.VertexElements);
    }

    public override void Update(GameTime gameTime)
    {
        CreateBBVertices();
        base.Update(gameTime);
    }

    .
    .
    .

    public override void Draw(GameTime gameTime)
    {
        //draw billboards
        .
        .
        .
    }
}

■Note  As you can see in the Initialize method, your component can access the main Game class. This 
allows your component to access the public fields of the main Game class, such as Game.GraphicsDevice 
and Game.Content.
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Using Your New GameComponent

Now that you have defined your GameComponent, you should add it to the list of GameComponent 
classes of your main Game class. Once added, its main methods will automatically be called.

The easiest way to do this is to create a new instance of your GameComponent and add it 
immediately to the Components list. An ideal place to do this is in the constructor of your main 
Game class:

public Game1()
{
    graphics = new GraphicsDeviceManager(this);
    Content.RootDirectory = "Content";

    Components.Add(new BillboardGC(this));
}

This will cause the Initialize and LoadContent methods to be called at startup and the 
Update and Draw methods of the new class to be called each time the Update and Draw methods 
of your main Game class have finished.

In some cases, you will need to update some public variables of the component. In the 
case of the billboarding component, you’ll need to update the camPosition and camForward 
variables so the component can adjust its billboards and the View and Projection matrices 
so they can be rendered correctly to the screen. Therefore, you’ll want to keep a link to your 
component by adding this variable to your main Game class:

BillboardGC billboardGC;

Then store a link to your component before storing it in the Components list:

public Game1()
{
    graphics = new GraphicsDeviceManager(this);
    Content.RootDirectory = "Content";

    billboardGC = new BillboardGC(this);
    Components.Add(billboardGC);
}

Now in the Update method of your main Game class, you can update these four variables 
inside your component. At the end of the Update method of your main Game class, the Update 
method of all components is called, allowing the billboarding component to update its billboards:

protected override void Update(GameTime gameTime)
{
    .
    .
    .

    billboardGC.camForward = quatCam.Forward;
    billboardGC.camPosition = quatCam.Position;
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    billboardGC.viewMatrix = quatCam.ViewMatrix;
    billboardGC.projectionMatrix = quatCam.ProjectionMatrix;

    base.Update(gameTime);
}

The Draw method of your main Game class is even simpler: just clear the screen before 
calling the Draw method of all the components:

protected override void Draw(GameTime gameTime)
{
    device.Clear(ClearOptions.Target | ClearOptions.DepthBuffer, ➥

    Color.CornflowerBlue, 1, 0);
    base.Draw(gameTime);
}

The last line will cause the Draw method of the billboarding component to be called, rendering 
the billboards to the screen.

The Code
The Initialize, LoadContent, Update, and Draw methods of the GameComponent and main Game 
class were listed in the earlier text.

1-7. Allow Your GameComponents to Communicate 
with Each Other by Implementing GameServices

The Problem
As explained in recipe 1-6, you can separate parts of your code into reusable GameComponent 
classes. Examples of such components can be a camera, particle system, user input processing, 
billboard engine, and more.

One of the main benefits of using GameComponent classes is that you can easily switch 
between, for example, camera modes. Changing from a first-person camera to a quaternion 
camera involves changing just one line of code in the Initialize method of your main Game class.

Using GameComponent classes to achieve this is one thing, but you need to make sure you 
don’t have to change the rest of your code (which uses the camera) when you switch from one 
component to another.

The Solution
You will make both your camera components subscribe to the same interface, such as the (self-
defined) ICameraInterface interface. When you initialize your camera component, you let your 
Game class know that from now on the Game contains a component that implements the 
ICameraInterface interface. In XNA words, the component registers itself as the GameService 
of the ICameraInterface type.
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Once this has been done, the rest of your code can simply ask the Game class for the current 
ICameraInterface service. The Game class will return the camera that is currently providing 
the ICameraInterface service. This means your calling code never needs to know whether it is 
actually a first-person camera or a quaternion camera.

How It Works
An interface is some kind of contract that you make your class (in this case, your GameComponent) 
sign. An interface contains a list of functionality (methods, actually) that the class should mini-
mally support. When your class is subscribed to an interface, it promises it implements the 
methods listed in the definition of the interface.

This is how you define an ICameraInterface interface:

interface ICameraInterface
{
    Vector3 Position { get;}
    Vector3 Forward { get;}
    Vector3 UpVector { get;}

    Matrix ViewMatrix { get;}
    Matrix ProjectionMatrix { get;}
}

Any class wanting to subscribe to ICameraInterface should implement these five getter 
methods. Whether it is a first-person or quaternion camera, if it is subscribed to the interface, 
then your main program is sure it can access these five fields.

For the rest of your code, it isn’t of any importance to know whether the current camera is 
a first-person or quaternion camera. The only thing that matters is that the camera can produce 
valid View and Projection matrices and maybe some other directional vectors. So, it suffices for 
your main Game class to have a camera that subscribes to ICameraInterface.

Making Your GameComponent Subscribe to an Interface

In this example, you will have two camera components. Because they don’t need to draw anything 
to the screen, a DrawableGameComponent is not necessary, so inherit from the GameComponent 
class. Also, make your component subscribe to ICameraInterface:

class QuakeCameraGC : GameComponent, ICameraInterface
{
    .
    .
    .
}

■Note  Although a class can inherit from only one parental class (the GameComponent class, in this case), 
it can subscribe to multiple interfaces.
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Next, you need to make sure your class actually lives up to its contract by implementing 
the methods described in the interface. In the case of the QuakeCamera and Quaternion classes 
described in recipe 2-3 and recipe 2-4, this is already the case. See the accompanying code for 
the minor changes in turning them into two GameComponent classes.

Subscribing to the ICameraInterface Service

You should have one, and only one, camera component that provides the ICameraInterface 
service at a time. When you activate a camera component, it should let your main Game class 
know it is the current implementation of ICameraInterface, so your main Game class knows it 
should pass this camera to the rest of the code in case it is asked for the current provider of 
ICameraInterface.

You do this by registering it as a GameService in the Services collection of the main Game class:

public QuakeCameraGC(Game game) : base(game)
{
    game.Services.AddService(typeof(ICameraInterface), this);
}

You add the this object (the newly created first-person camera component) to the list of 
interfaces, and you indicate it provides the ICameraInterface service.

Usage

Whenever your code needs the current camera (for example, to retrieve the View and Projection 
matrices), you should ask the main Game class to give you the current implementation of 
ICameraInterface. On the object that is returned, you can access all the fields defined in 
the ICameraInterface definition.

protected override void Draw(GameTime gameTime)
{
    device.Clear(ClearOptions.Target | ClearOptions.DepthBuffer, ➥

    Color.CornflowerBlue, 1, 0);

    ICameraInterface camera;
    camera = (ICameraInterface)Services.GetService(typeof(ICameraInterface));

    cCross.Draw(camera.ViewMatrix, camera.ProjectionMatrix);

    base.Draw(gameTime);
}

You ask your main Game class to return the class that provides the ICameraInterface interface. 
Note that the code inside this Draw method never knows whether it is talking to a first-person 
camera or quaternion camera. All that matters is that it supports the functionality listed in the 
ICameraInterface definition. As a benefit, you can easily swap between camera modes because 
your other code will not even notice this change.


